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Introduction

The Microsoft® Outlook™ 2000 messaging and collaboration client combines
leading support for Internet standards-based messaging systems, including
Exchange Server, with integrated calendar, contact, and task management
features.

The integration of this information provides users with a very powerful contact
management solution. Users can send e-mail or letters to their contacts. They can
manage specific contact task lists. They can associate appointments in their
calendar with their contacts. They can journal contact interactions. The contact
can view a history of all activities in which they are associated. With one click
from an associated item, like a task for a contact, the contact themselves can be
opened.

This paper gives an introduction to Microsoft Outlook contact management
capabilities. It demonstrates the powerful tools that Outlook provides to organize
large contact lists. This paper illustrates how contacts can be customized to fit
specific user needs. In addition, it shows how workgroups can share contact
information.

People who are interested in using Microsoft Outlook as a contact manager or as
an e-mail client should read this paper. Both seasoned Outlook users and users

who have never used Outlook will find the information in this white paper useful
because it combines on overview of basic functions as well as tips and tricks for
the advanced user.

About This Document

This white paper is organized in five sections:

» Contact Basics. The first chapter introduces Outlook contacts and
demonstrates how users can quickly build their own contact database. It
describes specific contact fields in detail. The first chapter presents the
new Outlook 2000 personal distribution lists and explains how Outlook
contact folders serve as address books for e-mail.
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* Interacting with Contacts. The second chapter shows how Outlook can be
the place where all interactions with contacts are initiated and
documented. Outlook users can send e-mail to their contacts and much
more. They can create contact specific task lists, link documents to
contacts and view all past interactions with a contact in an easy table
format.

» Organizing Contacts. The third chapter gives valuable tips on how to find
contacts quickly and how to organize large contact databases. This
chapter also presents time management tips. It explains when it is better
to use folders rather than Outlook messaging and collaboration client
powerful views to group contacts.

» Customizing Fields & Forms. The fourth chapter presents how contacts
can be customized to suit individual user needs. An insurance salesman
will store slightly different contact data than a consultant or a lawyer. To
provide the best contact management solution for them, Outlook can be
easily adapted to fit a users exact needs.

» Sharing Contacts. The fifth chapter describes how users can share
contact information in workgroups with or without Microsoft Exchange. It
gives a clear example of how an Exchange public folder workgroup space
can be setup to collaborate with a set of contacts. It explains how to
share journal entries with the history of contact interactions, manage
open tasks with work items and make e-mail messages send and
received by those contacts accessible to a team.

Contact Basics

Outlook contact folders allow users to store contact information with which they
interact in their lives-professional contacts like customers and vendors as well as
friends, classmates and family members.

This chapter explains how users can build a contact database. It shows how
existing contact information can be imported in Outlook and how contacts can be
created within Outlook. This chapter then moves on to explain specific contact
fields. It introduces new personal distribution lists for Outlook and shows how
Outlook contact folders are used as address books for sending e-mail.

Outlook offers two ways to look at contacts:

» Contact folders. Contact folders can be displayed in the main window on
Outlook. They can be shown in views as address cards-as shown
below-or in list form.

» Contact item windows. Contact item windows display one contact at a
time. They allow comfortable entry of contact data and use tabs to
structure information that a contact item can hold.

Using Microsoft® Outlook™ 2000 for Contact Management 2
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Building a Contact Database

Importing existing Contacts

Many users already have existing contact information on their personal
computers. Outlook offers an easy way to import those contacts. Outlook provides
an import/export wizard that can be started through the “Files=» Import and
Export...” menu.
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Supported Formats

Outlook imports from a variety of current contact managers such as Act, Ecco,
Lotus Organizer, Sidekick and Schedule+. It also allows import of contact
information from databases like Access and Foxpro and a variety of other file
formats.
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Mapping Fields

Outlook supports the mapping of import source fields to Outlook contact fields.
Drag fields from the list box on the left and drop them on the Outlook contact
fields on the right list box to match them upon import.
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Creating Contacts in Outlook

Outlook provides multiple ways to create contacts-from entering a contact with a
lot of information to quickly capturing an e-mail address or phone number.

New Contact

A new contact can be created through the contact’s “Actions” menus or the “New”
toolbar button on the standard Outlook toolbar. This is the best option for a user

who wants to enter detailed contact information from a business card, letterhead

or paper address book.

New Contact from the Same Company-

This can be created using the contact’s “Actions” menu. The company name,
business address and business phone numbers of the active contact are copied
from the existing contact to the new one. This option can shorten the time needed
to enter a contact if one from the same company already exists.

Views “New Row”

Outlook table views show a blank row at the top that allows direct entry of contact
information. This is a good way to quickly enter a contact name and phone
number.

A new contact can be
added by typing in
the view columns
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Forwarded Contacts and vCards

Contacts or vCards that have been forwarded as attachments of an e-mail
message can be dragged from the message and dropped into contact folders.
vCards present contact information as electronic business cards on an open
Internet standard. This is the fastest way to enter a contact. A customer or friend
can send his own contact information this way and colleagues can forward contact
information from their own databases.

Drag & drop on a
contact folder to add
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Create from Exchange Server Global Address Book Entries

Exchange e-mail users can add global address book entries by pressing the new
add to “Personal Address Book” button. All fields will be copied in a new Outlook
contact. This is a convenient way for a user to import selected colleagues
information into a contact folder-for synchronization to a hand held device or for

offline access.
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Address book entries for a contact can be opened using the standard Microsoft
Exchange address book. Users can also double-click or use the context menu on
any recipient name in an e-mail message or a task/meeting request as shown in
the following picture.

Create from E-maiil

E-mail can be created by simply right-clicking on any name in the from/to/cc/bcc
fields. This is a very fast way to enter the name of a person from whom the user
received e-mail in the contact folder.

Open Properties dialog for
exchange global address book Select to create anew
entries. contact

Use “Add to Personal Address
Book” button to add to contacts.
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Auto Merge Contact Information

If a user maintains a large number of contacts it is possible that contacts are
accidentally entered twice. If business partners send an electronic business card
with their e-mail messages the danger of duplicates is even higher because it
easy to drag the same business card in a contact folder twice. Therefore, Outlook
2000 checks every time a user adds a new contact for existing duplicates.

If a duplicate is detected, Outlook offers two options:

e Add the new contact as a duplicate-after all, a user might actually deal
with two contacts that have the same name.

 Update the existing contact with all the fields that have a different value
in the new contact file. This intelligent merge preserves existing field
values and only updates new information. A user receives a new
electronic business card (vCard) from John Doe. They can drag it on their
contact folder, it already exists, the dialog is activated and they choose
to update. John Doe’s new fax number will be added to his existing
contact, but the notes that user made about John’s hobbies will not be
touched.
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Users can also choose to open the existing contact to verify its information.
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Contact Fields

The contact item window presents a row of tabs on the top that structure the
fields that allow users to capture contact information.

General Tab
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Name

Outlook automatically parses the entered name into title-first, middle, last name
and suffix. This makes it very easy to enter names, but still allows users to sort a
contact list by last name only.
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Company and Job Title

The company name and job title for the contact can be entered in these fields.
Use the full-name dialog box to enter fields manually.

File As

The File As field displays a contact name in different combinations of last name,
first name and company. Scott Cooper working for Exploration Air can be filed as
“Scott Cooper,” “Cooper, Scott,” “Exploration Air,” “Cooper, Scott (Exploration
Air)” or “Exploration Air (Scott Cooper).” You can also type in your own key, for
example,. “Doctor.”

File As is very useful as a sort by field. Contacts from the same company can be
shown together if they are filed as “Company (Name).” Contacts representing
companies might not have a first, middle or last name. Just the company field will
be filled in, so sorting the contact list by the last name would produce a list with
all companies first-their full name is blank-and all contacts with a name. Sorting
by File As solves this problem.

Address fields

Outlook offers three address fields: Business, Home and Other. One of these
addresses can be selected as the default address-this address is used when a
letter is created for the contact.

The address can be entered in one multi-line text field and is automatically
parsed.
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E-mail address and Web Pages

Outlook allows users to specify three e-mail addresses and one web page for each
contact.

Phone Numbers

Outlook provides 19 fields in which to save phone numbers. The buttons next to
the phone number field permit the user to select which numbers are displayed.

Contacts

This field allows contacts to be associated with other contacts-for example, the
contact representing Mr. Cooper is associated with the contact representing his
company “Exploration Air.” The contacts in the field can be opened using double-
click or through the context menu. The secretary of a contact can be associated in
this way as well. If Mr. Cooper is not picking up his phone, it is very easy to
navigate to his secretary, see her phone number and give her a call.

Categories

The categories field allows organization of contacts in category groups like
“Business” or “Friends.” Views in Outlook can then be manipulated to show only
contacts that belong to a certain category or to group by categories. Outlook
provides a standard set of categories that can be freely changed and extended.

Private

Users can allow assistants access to their contact folder. This permits a user to
give an assistant access to her contact folder. The user, however, might not wish
to share the contact information of an old college friend or of a relative. With this
field, they can mark those contacts as private and they will not be accessible to
delegates.

Detail Tab
The detail tab allows additional contact information to be stored.

38 Yool Canpsr - Coalact
Ble £t wow fuert Fomet loch Sters belp Dates entered
B seve nd cose B3 b TRLEa- e-w-BML. gligmatically
m|m]m|wﬁm]ﬂrﬂul || create calendar
:I [ioes [P— entries.

Offaga: I Emmkard 'y narpa: I

Frofeaman; | Rabes Manargen
q Picknars;  |soty Satheday: [rusine =

SIS Mes ! [Zrem-.- Ay IW;I
il MeMeeting seltings

ﬁ- Caetipy semver: |
E-nal sl

I _ cahen |

Ik Fres-Susy
Iﬂm |hl:r_ L a0y, poand B ool oaner s

Using Microsoft® Outlook™ 2000 for Contact Management 10



Department, Office, Profession, Manager, Assistant, Nickname, Spouse
Additional information fields.

Birthday and Anniversary

Setting these fields automatically creates calendar entries with yearly
reoccurrence that are excellent reminders.

Net Meeting Directory Server

The directory server stores the NetMeeting settings for with this contact. Microsoft
NetMeeting offers a complete Internet and intranet conferencing solution that lets
you easily communicate and collaborate with others on your company's intranet
or the Internet. Users see and hear meeting participants, look at the same
documents and folders or use a whiteboard to create simple illustrations. They
can also exchange text, chat, message and share files. Check
http://www.microsoft.com/windows/netmeeting/ for more information.

Other Tabs
Activities

Shows Outlook items that are associated with this contact-this tab will be
explained in detail under Interacting with Contacts-Tracking Activities.

Certificates

Allows the registration of security certificates to send and receive encrypted e-
mail from this contact.

All Fields
Shows a tabular listing of all contact fields.

Distribution Lists

Outlook 2000 supports personal distribution lists in contact folders. If a user
sends e-mail regularly to the same group of people they can create a distribution
list for this group. Future e-mails can then be addressed to the distribution list
and will be send to all members. A good example of a personal distribution list is
a project team-since a team member has to send regular updates to their group
they can create one distribution list with their team members instead of entering
the names every time they send e-mail.

Users can employ the “Actions” menu to send e-mail or meeting requests to
distribution lists.
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Creation of distribution lists

Distribution lists are created through the contact folder “Actions” menu or the
“New” toolbar button.
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Adding Members

New distribution list members with existing address book/contact folder entries
can be added using “Select Members” dialog.

Contacts that do not exist in any address book can be added using the “Add New”
dialog.

Updating Member Addresses

Whenever e-mail is sent to a distribution list, Outlook automatically checks if the
e-mail address of a distribution list member in the underlying contact or global
address book entry has changed. If so, the new address is used to send mail.
Users can visually update the e-mail addresses shown in the distribution list
window by pressing the “Update Now” button.
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Contact Folders as Address Books

Outlook uses the default contact folder as an e-mail address book. Other contact
folders can be used as address books as well. This allows users to organize their
contacts in multiple folders. Some users create one contact folder for business
contacts and one for private contacts. Others share customer contacts with their
teams in a public contact folder. All these contacts can be used to address e-mail.
Outlook will try to resolve a name entered in the e-mail address field against
contact entries in address books. Users can also select an address using the
“Select Names” dialog that can be opened from e-mail messages.
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There are two steps involved in activating a contact folder to serve as an e-mail
address book.

Setting the Folder Property

Open the “Contact Properties” dialog using “File=»Folder=>Properties” for “Folder
or the contact folders context menu. Select the tab “Outlook Address Book” and
check the “Show folder as an e-mail Address Book” check-box.
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Adding the Folder to the Address Lists

Open the “Services” dialog using “Tools=>Services”. Adjust the order in which
address lists are searched.
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Interacting with Contacts

Entering contact information in Outlook contact folders and using contact folders
as e-mail address books is only the first step to effective contact management.
Outlook contacts serve not only as an address book for e-mail, but can be the
place where all contact interactions are initiated. Outlook can be used to schedule
appointments with contacts, to automatically dial and document phone calls, to
write letters, to initiate NetMeeting conferencing software, to begin mail merge
processes and to start many other activities.

Outlook also allows users to view a complete history of their interactions with a

contact. For example, e-mails send to or received from a contact, journal entries
created to log interactions, or tasks due can be quickly reviewed before another

interaction-like a phone call-is started.
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Creating and Documenting Contact Activities

Contact related actions are activated via the contact’s “Actions” menu. The most
important contact actions can also be initiated using a right-click on the contact in
the main window of Outlook.
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All Outlook items that are created from a contact are automatically associated
with that particular contact.

New Letter to Contact

The Microsoft Word Letter Wizard is started and initialized with the contact’s
mailing address. If the mailing address is also the business address, the contact’s
job title and company name are included in the address.

New Message to Contact

A new e-mail message addressed to the contact is created.

New Meeting Request to Contact

A meeting request addressed to the contact is created. A meeting request is send
as an e-mail message to the contact. A calendar entry in the user’s calendar is
created as well.

New Appointment with Contact

A new appointment is created for the contact. This command does not send an e-
mail to the contact and is the preferred way to create appointments that are not
scheduled or confirmed by e-mail.

New Task for Contact
A new task item is created for the contact.

Using Microsoft® Outlook™ 2000 for Contact Management 15



New Journal Entry for Contact

A new journal entry is created for the contact. Journal entries allow users to
record notes about contact interactions like phone calls or meeting notes. The
“Activities” tab on each contact allows them to see a history of all journal entries
for the contact. The “Activities” tab is explained in detail in the section “Tracking
Activities”.

Links

Links allow users to associate existing items, like tasks or appointments, as well
as documents with a contact. Existing outlook items can be selected from
dialog-their “Contacts” field will be set to the selected contact. To associate
documents, Outlook offers the user a file-open dialog and creates a journal entry
with a shortcut to this file. This is a great way to associate documents like sales
proposals or letters with a contact.

Phone Calls

Outlook can automatically dial contact phone numbers if a modem is installed on
the user’s computer.
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Call Using NetMeeting

Initiates a NetMeeting™ conference. To learn more about NetMeeting conferencing
software, check http://www.microsoft.com/windows/netmeeting/|

Display Map of Address

Activates Microsoft Expedia Maps, a free web site. For US addresses the exact
street address is mapped, for places in other countries a high level map of the city
is shown.

Explore Web page
Will open the contact’s web page.

Flag for Follow Up

Setting a Flag on a contact is an excellent way for users to remind themselves of
an action that needs to be taken for this contact. With the Flag users can enter a
custom follow-up action or pick from standard text like “Follow up, Call, Send e-
mail.” They can also set a reminder that will notify them at a specified time.
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Forward/Forward as vCard

Creates a new e-mail with the contact attached in Outlook or vCard format. This
allows users to share their contact information with others.

Tracking Activities

The “Contacts” Field on Outlook Items

The “Contacts” field associates any Outlook item with a contact. A user can see a
task to call a customer in his task list. One double-click on the contact’s name in
the “Contacts” field and the contact is opened with the phone number visible and
ready to be dialed. A meeting with a contact has to be rescheduled by telephone.
Again, one click on the name opens the contact and presents the phone number.

The “Contacts” field is automatically set to the contact name when an item is
created through the contact’s “Actions” menu. A contact name can also be
manually entered or selected from a dialog activated by clicking the “Contacts”
button.
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Contact Name — right click
for context menu, double
click to open
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Showing Activities on the Contact Item Window

On the contact item window Outlook provides the “Activities” tab to show all items
related to a contact. Outlook searches defined folders for matching entries in the
“Contacts” field and for matching e-mail addresses in mail messages. Users can
select different folder groups with the combobox in the upper left corner.

Pick different Views—
Predefined or customized
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Full Outlook view —
customize columns, sort,
group by...

The Views

The views on the “Activities” tab are fully customizable Outlook views. Users can
change the displayed fields, sort order, group by settings and other settings-like
gridlines and fonts.

The items displayed in the table can be opened using their right-click menus,
double click or acted on with the right click menu.

The Predefined Folder Groups

Outlook ships with six predefined folder groups: “Journal,” “Upcoming
Tasks/Appointments,” “Contacts,” Notes,” “E-mail” and “All Items.” The first four
folder groups are for searching Outlook default folders. E-mail searches the whole
store, since Outlook can not know which folder structure users will employ to
archive their e-mail.
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Customizing Folder Groups

To customize the searched folder groups the user has to activate the “Contact
Properties” dialog of a contact folder through the “File=»Folder=>Folder Properties”
menu.
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Recommended customizations:

e Searching the full mailbox of a user for e-mail can be time consuming.
The search can be sped up if the user defines the exact e-mail folders
that should be searched-like “Inbox, Outbox, Sent Items” in the
example.

» Users can define folder groups in archive folders to be searched. Using
archive folders is recommended since it minimizes the size of a mailbox.

Setting the Default Folder Group

This tab also allows users to set the default view that will be shown when the
activities tab on the contact form is selected.

The Activities tab-an Evolution from the Outlook Journal

In Microsoft Outlook 97/98 the “Activities” tab was called “Journal”. It only
displayed journal entries and it was not possible to see other items like tasks or
calendar entries.

The journal can be configured to automatically create a journal entry for e-mail
and meetings or task requests received by or sent to a contact. In Outlook 98,
this was a good way to see past interactions with a contact. In Outlook 2000, e-
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mail messages, tasks and appointments can be show directly on the “Activities”
tab and it is no longer necessary to create journal entries for them.

Outlook 2000 switches automatic journaling by default. We advise users who
employed this feature in Outlook 98 or Outlook 97 to switch automatic journaling
as well.

Mail Merge to Contacts

Microsoft] Word has powerful Mail Merge capabilities. Personalized letters can be
send to many contacts, labels and envelopes can be printed for mass mailings and
even personalized mass e-mails can be sent out from Word. While Word is
providing the Mail Merge capabilities, Outlook allows the user to provide the
contact information. Users can set a filter in the current view of contacts in an
Outlook contact folder-for example, to show only contacts with the category
“Prime Customers.” When they initiate the Mail Merge process through the
“Tools=>Mail Merge” menu in contact folders, only contacts that match that filter
are exported to Word.

This feature requires Microsoft Word 95 or higher.
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Selecting Contacts

Starting Mail Merge from Outlook takes advantage of the Outlook powerful view
architecture. Users can filter on all fields of a contact-standard or user-defined.

Contact Fields

By default all contact fields are exported to Microsoft Word for use in the Mail
Merge and again, custom fields are fully supported. Users can specify to employ
only fields that are displayed in their current view-which speeds up the export
process and creates smaller files.
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Contact Data

Outlook exports selected contacts to a temporary file that is automatically cleaned
up after use. Users can specify a file name if they want to reuse the exported
contacts later or if the creation process of the Mail Merge document stretches over
multiple days.

Main Document
Users can also specify to create a new document or to use an existing file.

Merge Options

Outlook supports all Microsoft Word merge types. Users can create form letters,
catalog lists, envelopes or labels. The Mail Merge process can create a new
document or output to a printer. It can also send faxes or e-mail messages.

Printing Contact Information

Even in the information age it is still important to print data on actual paper for
use in a paper organizer or to bring to a meeting. Outlook can print contact
information in many ways.

Standard Format

Outlook can print contact information on standard paper sizes supported by a
user’s printer, but also on many different custom paper formats like Day-Timer,
Day Runner, FiloFax, Franklin Day Planner and Avery.
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Single Contact

Users can also print the information of one contact in an Outlook specific format
that shows all valuable properties.

Views

Views can be printed exactly as they are defined on screen. Fields visible in the
view will be printed.
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Organizing Contacts

A user can not work with a contact if they can not find it. This chapter will show
how Outlook helps the user to find contacts. It will also illustrate how Outlook
allows users to structure a large contact database to fulfill their individual needs.

Finding a Contact

Activate
“Advanced Find”

QuickFind — enter name
and hit return
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Type ahead functionality Click togo to first
on sort by field contact starting
with “M”
QuickFind

A combobox on the standard Outlook toolbar. Outlook searches contact folders
and the Exchange global address book, then opens matching contacts. Since this
combobox is visible in all modules, it allows users to find contacts without leaving
the module they are currently using.
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Find Pane

Activated through “Tools=»Find” or the “Find” toolbar button. Contact’s name,
company, address, category fields and optionally the notes field are searched for
text entered in the Find Pane edit field.

Type Ahead

Typing in non-editable views will scroll to the entry that matches the sort by
field-In the picture typing “Bell” activated “Bellevue Community College”.

Index Tab in Card Views

Just like a real organizer, Outlook Card View displays letters of the alphabet on
the right site-click the letter to navigate to the first entry starting with the
respective letter.

Advanced Find

Activated using the menu “Tools=» Advanced Find” or the folder context menu.
Allows for complex searches of one or multiple contact folders.

Look up e-mail recipient
The context menu of e-mail recipients allows the look up of contacts.

Look up Contact
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Organizing Groups of Contacts

Folders

Users can create as many contact folders as they like. It makes sense to clearly
separate contacts in contact folders if their group membership will does not
change. For example, a good use of contact folders would be to create a folder
“Friends and Family” and a folder “Business”. It is very unlikely that a user will
start to do business with his mother or will become a close friend with a customer
contact. A bad use would be to create a folder “Contacts to call this week”-the
user would end up copying contacts back and forth all the time.
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Views

Views allow users to present contacts in one folder in a user defined form. Users
can filter out specific contacts, decide which fields are shown, group by certain
fields and set other formatting options. Views are the right tool to build contact
groups when the group membership is based on frequently changing contact
fields. The category of a customer might change from “normal” to “preferred,” a
customer might be flagged for a follow up call one week and might be without a
flag set the next.

The first big benefit of Views is that they are dynamic. As soon as the field of the
contact is set, its group member ship is established. The following View is
grouped by Flag Status. If the Flag Status of a contact is set, it will immediately
appear in the “Flagged” group. The second big benefit of Views is that a contact
can appear in multiple Views at the same time while it can only live in one folder.
A user can use a View “Best Customers” to determine who gets the free baseball
tickets and a View “Next Actions” to show the customers that are flagged for
action. One customer can appear in both Views.

The users can create as many Views as they need and can customize a wide array
of parameters. A View with all its settings can be saved under a name.

Sort by afield.
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View Type

Users can create Views of different type-for contact folders the two important
ones are the card view and the table view. The Card View shows a small card for

each contact, the Table View shows contacts in a list form.

Activating Views

Users can activate views through the “View=>»Current View” fly-out menu or using

the organize pane.

Show the
“Organize’

Pane
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Saving Views
Users can save views via the “Define Views” dialog activated by the
“Views=>Current View=>Define Views” menu.
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View Properties

The “View=>Current View=>»Customize Current View” menu or a right click on the
column headers of a table view activate the “View Summary” dialog.

Right click Context menu
column headers

View menu
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Fields

Users can freely pick which fields are displayed in any view type. It is possible to
display standard Outlook fields as well as user-defined fields.

Group by

Contacts can be displayed in contact groups based on contact fields. Groups can
be expanded or collapsed by clicking on their header rows. A view grouped by
Flag Status would show all contacts that are flagged for a follow-up action in one
group.
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Sort

Views can by sorted by any field. Clicking on the column header sorts a view by
this column.

Filter

Very powerful filters can be defined for a view. If a filter is set, the view will only
display the contacts that satisfy this filter. For example setting the filter to
“Categories = Business” will only show business contacts.

Other Settings

Users can define the font of the view, control whether or not gridlines are shown,
or switch on a third pane that displays the note field of contacts.

Automatic formatting

Users can decide to define special formatting rules for the display of individual
contacts. For example contacts of the category “VIP” could be displayed in red,
bold font.

Customizing Fields & Forms

While Outlook provides many fields for contact information, it is not possible to
satisfy every user. Therefore it is easy for users to create their own special fields,
add them to views and contact forms.

Adding Fields

It is easy to add fields to contacts in an Outlook contact folder.

Type of field

Users can freely name their fields and choose from a large variety of data type
and formatting options.
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Add new fields in the following ways:
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» Field Chooser. Users can activate the Field Chooser through the column
header’s context menu. The Field Chooser has a “New” button that shows
the “New Field” Dialog. Newly created fields can be dragged from the
field chooser into the active view. The Field Chooser can also be
activated in the Forms Design view of a contact form.

* View customization. Users can activate the “Show Fields” dialog of the
“View summary” dialog.
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Customizing Forms

Outlook allows full customization of contact forms, including customization of the
first tab. Users can simply add additional fields to be displayed, but can also use
the full power of the Visual Basic Script programming language to create complex
custom forms. This section will give a quick overview. More detailed information
can be found in the Forms Design Help file.
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Step 1: Entering Design Mode
Enter design mode from any form in a contact folder using “Tools=»Forms=>»Design
This Form.”

Step 2: Making changes

Design the form by moving, removing and adding fields and pages in the form. All
fields in the form and all fields added from the Field Chooser retain their built-in
properties and functions.
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Step 3: Publishing the form
Publish the form to the contact folder using the “Tools=»Forms=>Publish Form”
command.

Step 4: Creating a new contact with the custom form

« Make the new form the default form. On the “General” tab of the
“Contacts Properties” dialog, the new form can be set as the default form
for this folder. All commands that create a contact like the “Actions”
menu or the new toolbar will now use this form to create new items.

* Use “Actions” menu. If the form was published in the contact folder a
“New Form Name” command will be appended to the “Actions” menu for
each custom form in this folder.
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Note: Outlook saves a form design with each contact. That means that the form
design of existing contacts is not changed when a new form becomes the default
form for a contact folder.

This design is very powerful because it allows multiple form designs to coexist in
one contact folder. However, this means that the forms of existing contacts do not
automatically change when the folder’s default form is modified. A Component
Object Model (COM) add-in that allows users to switch the forms of existing
contacts will be available for download on the Outlook 2000 web site at
http://www.microsoft.com/}

Sharing Contacts

Sending Contact Information by E-mail

Outlook makes it very easy to forward contact information through e-mail. Users
can attach any number of Outlook contacts to an e-mail message using the
“Insert=>»Item” dialog. They can also directly forward a contact as a vCard or as an
Outlook contact through a contact’s “Actions” menu.

NetFolders

NetFolders-an add-on component introduced in Outlook 98-allow users to easily
share information over e-mail without an Exchange Server. To share a folder, the
user chooses Share from the File menu. Subsequent changes to the folder are
then broadcast to users via e-mail. The e-mail does not appear in users’ inboxes,
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but is instead used by Outlook to update the folder on each user’s computer. With
NetFolders, users can share information with anyone to whom they send e-mail.
NetFolders give smaller organizations without Exchange Server or users that are
travelling with laptops an easy way to share contact folders.

Exchange Server

Contact Centric Collaboration around Public Folders

In many cases more than one person is working with a set of contacts-like a team
composed of sales people, marketing and technical staff and support personal. To
provide the best service for the customers, the activities of this group have to be
coordinated. Everybody has to know what meetings took place, what e-mail
messages have been exchanged and which tasks still have to be completed.

In Microsoft Exchange, users can create public folders to share this kind of data in
workgroups. Outlook 2000 supports contact activity tracking in public folders.
Journal entries, tasks and e-mail items can be stored in a public folder and viewed
from the Activities tab of a public contact. The following example explains how to
set up a contact centric workgroup collaboration space.

Administrator/work group manager set up:

e Create Public Folders. Create a contact folder in the public folder space.
Create a journal, task and e-mail folder as subfolders to this contact
folder.

e User Permissions. For each of the folders give access permission to team
through the “Permissions” tab of the folder properties.

« Define Folder Groups for Activities Tab of Contacts in the Contact folder.
Select the work group contact folder, open its properties dialog and
activate the “Activities” tab.
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Customize the Activities View. Create a contact in the public contact
folder, go to the “Activities” tab. The “Show:” combobox now contains the
two folder groups that were defined. Customize the view to show the
columns and view settings that all users in the group should see by
right-clicking on the column headers or using the “View” menu.
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Notify users of the new folder. Send a shortcut of the contact folder to
the users who will work with this contact folder using “File=»Folder=>Send
Link to Folder”.
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Work Group member set up

» Adding the contact folder to favorites. Because the public folder favorite
group has a “per user” setting, each user has to individually add the
contact folder with its subfolders to their own favorite group. This is
easily done by opening the folder and using the “File=»Folder=> Add to
Public Folder Favorites” command.
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* Registering the contact folder as an address book. If the user wants to
implement the contacts in the public contact folder as an e-mail address
book they have to configure the contact folder on the “Folder Properties”
dialog. This registration also enables the QuickFind toolbar to search this
contact folder.
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Working with the contacts in the folder

» Creating new associated items. All the “Actions” menu commands create
items that will be saved in the user’s default folder. Therefore, new items
should not be saved with the “Save” or “Save and Close” commands,
rather with the “File=»Move to Folder” command.
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* Viewing Shared Activities. The “Activities” tab will now show the items
that are stored in the folder groups that the administrator defined.
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Sharing E-mail
It is a very common need to share incoming and outgoing e-mail from contacts

within a workgroup. Exchange allows user to address e-mail directly to a public
folder.
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Add to Address book

Users add the folder to their address book through the “Folder Properties” dialog
“Administration” tab. That allows them to address the folder in e-mail just like
they would a regular contact

Forward or Blind Carbon Copy

Users can now forward incoming e-mail to that folder. They can enter the folder
address in the “BCC:” field of outgoing e-mail to make copies of the e-mail
available to their group members. “BCC” stands for “Blind Carbon Copy”-the
customer who receives the e-mail is not able to see that it was copied to a work
group folder.

Synchronizing Contact Information with Hand Held PC’s

Microsoft Outlook 97 and Outlook 98 can exchange information such as e-mail,
schedules and contacts with a variety of handheld computing and communication
devices, such as Windows"” CE Handheld PC computers, the Rex card from
Franklin Publishing, the PalmPilot from Palm Computing, and certain cellular
phones.

For more information, please visit the Outlook web site at

http://www.microsoft.com/outlook/ for references of third-party products.

For more information: |http://www.microsoft.com/office/|
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